
Student Resources: labyrinthelab.com/esl5

C H A P T E R  3

Windows Programs

Computer Objectives

■ Use computer hardware and software

■ Use a program Ribbon

■ Open a dialog box and work with a drop-
down list

■ Draw a picture in the Paint program

■ Use the Calculator program

■ Play a computer game

Language Objectives

■ Use vocabulary words to describe parts
of different programs

■ Use computer verbs to describe actions you
can do with different programs

■ Talk with a partner about drawing a picture in
the Paint program

■ Talk with a partner about the different kinds
of tasks you can do with programs
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40 Chapter 3 | Windows Programs

 Vocabulary

Picture Dictionary — Nouns
A noun is the name of a person, place, or thing. The following nouns are introduced in this chapter.

1. Dialog box – A window with boxes you
can click to select what you want

2. Checkbox – A box you can click to select
an option you want

3. Drop-down list arrow – An arrow you
can click to make the drop-down list
menu appear

4. Drop-down list menu – A list with
options you can choose from

ESL5-c03_WindowsPro.indd   40 4/12/18   8:54 PM

Welcome to Computers for ESL Students 5e   FOR EVALUATION ONLY © 2018 Labyrinth Learning – Not for Sale or Classroom Use

Labyrinth Learning  http://www.lablearning.com

EVALU
ATIO

N O
NLY



Vocabulary 41    

5. Hardware – The physical parts of the
computer system, such as the monitor or
the keyboard

6. Software – Programs added to the
computer system that are not hardware,
such as Word

7. Appearance – The way an object looks,
such as on the computer screen

The word appearance is a noun. The word appear is a verb.

8. Settings – Information about how a
program is set up

9. Menu button – The button you click to
open a menu. There are different ways
that a menu button can look.

NOTE!
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42 Chapter 3 | Windows Programs

Computer Verbs
A verb tells an action or what a subject is or does. The following verbs are introduced in this chapter.

VERB MEANING EXAMPLE

1. Appear When an object shows and you 
can see it

When you click the box, a checkmark 
will appear inside the box.

2. Check To click a box so that a 
checkmark appears

When you have a few choices, you must 
check the one that you want.

3. Clear
(a box)

To click a button or box to 
remove what you checked 
before; to uncheck a box

I changed my mind, so I have to clear 
the box that I checked before.

4. Release
(a button)

To take your finger off the 
mouse button

After you finish your mouse action, you 
should release the mouse button.

5. Let up To release or let go of the button Another way to say “release the mouse 
button” is to say “let up on the mouse 
button.”

Release and let up are synonyms. Synonyms are words that have the same or a 
similar meaning.

6. Play To use a computer game I like to play Solitaire and other card 
games on my computer.

7. Preview To see how information will look 
when it is printed so you can 
decide what you want to do

I want to preview how the document will 
look before I print it.

8. Hold
(a button)

To keep your finger pressed on 
the mouse button

Sometimes you have to hold down your 
mouse button for a few seconds, and 
sometimes you only have to tap it.

9. View To look at an object It is important to view the tools on the 
toolbar so you can see the choices.

NOTE!
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Concepts and Exercises 43    

 Concepts and Exercises

Common Features in Programs
A program is a set of directions that tells the computer exactly what to do to get a certain kind of job 
done. Not all programs look the same.

Here are examples of kinds of programs that do different jobs.

A word-processing program is used to type text.

A spreadsheet program is used mostly for 
numbers.

A graphics program is used to make and change 
pictures.

A web browser is used to find things on the 
Internet.
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44 Chapter 3 | Windows Programs

exercise 3.1

In this exercise, you will use the Start button to start the Word program. There are 

different versions of Word. Your computer may show a number after the program 

name. The recent versions of Word look and function very similar.

You may have to use the scroll bar to move down to the “W” section to see it.

Word opens on the screen.

3. If the Word window does not fill the screen, click the Maximize  button.

4. Find the title bar on the screen and point at it with the mouse. 

5. Find the Ribbon and the work area. Move your mouse pointer over each part.

Leave Word open for the next exercise.

2. Click Word 2016. 

If your computer 

has a different 

version of Word, 

such as Word 

2013 or Word 

2010, choose 

that. Click Blank
Document.

1. Click Start.

TIP!

A computer game is used to relax and have fun.
A tutorial is used to show and teach ideas.

Different programs have many parts that are the same. Most program windows have these parts.

A second example of a program is Paint.

Word program window

A	Title bar: Tells you the 
program you are using

B	Ribbon: A bar with 
different buttons; each 
button does a different 
job when you click it

C	Button: Icons that do 
different jobs when you 
click them with the mouse

D	Work area: The place 
where your work shows

Paint program window

A	Title bar: Tells you the 
program you are using

B	Ribbon: A bar with 
different buttons; each 
button does a different 
job when you click it

C	Button: Icons that do 
different jobs when you  
click them with the mouse

D	Work area: The place 
where your work shows
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exercise 3.1 

In this exercise, you will use the Start button to start the Word program. There are 

different versions of Word. Your computer may show a number after the program 

name. The recent versions of Word look and function very similar.

You may have to use the scroll bar to move down to the “W” section to see it.

Word opens on the screen.

3. If the Word window does not fill the screen, click the Maximize  button.

4. Find the title bar on the screen and point at it with the mouse.

5. Find the Ribbon and the work area. Move your mouse pointer over each part.

Leave Word open for the next exercise.

2. Click Word 2016.

If your computer

has a different

version of Word,

such as Word

2013 or Word

2010, choose

that. Click Blank
Document.

1. Click Start.

TIP!
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46 Chapter 3 | Windows Programs

Dialog Boxes
Most programs have some type of dialog box. You can change settings by changing the information 
in a dialog box. Many dialog boxes have these features.

A	Checkboxes: Click in the boxes to check or uncheck them.

B	Drop-down list arrow: An arrow that points down that you can click to open a drop-down list 
menu.

C	Drop-down list menu: A list of choices that opens when you click a drop-down arrow.

The Word Font dialog box

B

A

C

ESL5-c03_WindowsPro.indd   46 4/12/18   8:54 PM

Welcome to Computers for ESL Students 5e   FOR EVALUATION ONLY © 2018 Labyrinth Learning – Not for Sale or Classroom Use

Labyrinth Learning  http://www.lablearning.com

EVALU
ATIO

N O
NLY



exercise 3.2 

In this exercise, you will use a dialog box in Word. The program should be open from 

the last exercise.

This dialog box will appear on your screen.

3. Find a drop-down arrow, a drop-down list menu, and a checkbox.

4. Click the Font Color drop-down arrow to open the drop-down

list menu.

5. Close the dialog box with the Close  button. Then, close Word.

1. Click the Home tab.

2. Click the dialog box

launcher in the Font

section.
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48 Chapter 3 | Windows Programs

Using Tools on a Ribbon in Paint
Paint gives you many tools to work with to make pictures. Some are easy to use and some take a 
while to learn. We will look at the easy ones now.

■ You can use tools on a Ribbon by clicking on them.

■ When you click on a tool, a symbol appears in place of the mouse pointer. Each tool has its own
symbol.

We will not use all the tools, only a few to see how they work. Here are some of the tools. To use a 
tool, click it. 

Tools only work in the white area of the Paint window. If you want to pick a color, click on one of the 
colors on the right side of the Home tab of the Ribbon.

D	Shapes, including the Line toolC	PaintbrushesB	Eraser

A	Pencil

A	Paint colors
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Dragging

To use a tool, you need to drag with the mouse. (For a definition of drag, see Chapter 1, “About 
Computer Basics.”) Here is how: 

1. Point where you want to start and then hold down your left mouse button.

2. Move the mouse to make your design.

3. Let go of the left mouse button when you are finished making the design.

You will use drag in the next exercise.

exercise 3.3 

In this exercise, you will use some of the drawing tools in Paint. 

If necessary, drag the scroll box down until you see Paint.

1. Click the Start button.

2. Click Windows
Accessories. Use

the scroll bar to

help you find it.

3. Click Paint.
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50 Chapter 3 | Windows Programs

Draw a Line

4. Maximize  the Paint window if it does not fill the screen.

5. Click the Shapes button on the Ribbon and choose the Line tool from the menu.

6. Point to a place on the left side of the white area. Hold down your left mouse button

and keep it held down until step 8.

 7. Move the mouse to the right. This draws a line.

You should see a line.

 8. Let go of the mouse button where you want to stop the line.
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Draw a Box

9. Click the Shapes button and choose the Rectangle tool from the menu.

10. Point to a place anywhere on the white

area. Hold down the mouse button and

move it in the direction shown.

11. Let go of the mouse button.

ESL5-c03_WindowsPro.indd   51 4/12/18   8:54 PM

Concepts and Exercises 51    

Welcome to Computers for ESL Students 5e   FOR EVALUATION ONLY © 2018 Labyrinth Learning – Not for Sale or Classroom Use

Labyrinth Learning  http://www.lablearning.com

EVALU
ATIO

N O
NLY



52 Chapter 3 | Windows Programs

Draw a Colored Line

12. Click the Pencil tool. 13. Click the color Red from the Colors box.

 14. Point anywhere on the white area. 

Hold down the mouse button 

and then move the mouse up and 

down and to the right to paint a 

curving line.

15. Let go of the mouse button.

16. If you make a mistake, you can erase it with the Eraser .

17. You can keep drawing to add anything else you like to your picture.

18. When you are finished, closePaint.

19. If Paint asks you to save your file, choose No.

If you already know how to save a file, click Yes and give the file a name.

You will learn how to save your files in Chapter 5, “More with Word.”NOTE!
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The Windows Calculator
The Calculator is another program on the computer. You can use it to do many calculations. The 
program looks just like a handheld calculator and works the same way. You can type numbers or you 
can click the number buttons.

HOW TO USE THE CALCULATOR

Open Calculator: Start→Calculator

Examples of the four basic operations:

Add Two Numbers

A. Click the first number.

B. Click the plus (+) sign button.

C. Click the second number.

D. Click the equals (=) sign button.

Subtract Two Numbers

A. Click the first number.

B. Click the minus (–) sign button.

C. Click the second number.

D. Click the equals (=) sign button.

Multiply Two Numbers

Use the X (X) button: (3 X 2 = 6).

Divide Two Numbers

Use the division (÷) button: (8 ÷ 2 = 4).
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54 Chapter 3 | Windows Programs

exercise 3.4 

In this exercise, you will use the Calculator to add and subtract. You do not have to type 

in the numbers. Just click the number buttons with your mouse.

1. Open Calculator: Start→Calculator

Add Two Numbers

2. Click the 2 button two times for 22.

3. See the number in the number box.

4. Click the plus sign (+) to add the next number.

5. Click the 3 button two times for 33.

6. Click the equals sign (=) to finish.

You can see the answer (55) in the number box.

7. Click the C button to clear the Calculator.

3

2 5 4

6

7
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Do Other Calculations

Press C to clear after you complete each of the calculations in 
steps 8–11.

8. Click these buttons on the calculator: 12 + 6 =

9. Click these buttons: 100 + 75 =

10. Click these buttons: 50 – 10 =

11. Click these buttons: 389 – 14 =

Leave the Calculator open for the next exercise.

Using a Menu
Once you have had some practice using menus, you will find that they are easy to use. The way they 
work is the same in each program. What changes in each program is the list of choices in the menu.

■ You can open a menu by clicking the menu  button or one of the words at the top. Not all 
programs have menus. Some only have a Ribbon or other buttons.

■ Sometimes when you click on one of the menu items, a dialog box will open.

■ Sometimes a menu will show on the left side of the window.
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56 Chapter 3 | Windows Programs

exercise 3.5 

In this exercise, you will use a menu. Many settings can only be changed by using 

menus.

1. Click the menu button.

2. Choose Scientific.

The Calculator now shows the Scientific view with more advanced buttons.

1

2

ESL5-c03_WindowsPro.indd   56 4/12/18   8:54 PM

Welcome to Computers for ESL Students 5e   FOR EVALUATION ONLY © 2018 Labyrinth Learning – Not for Sale or Classroom Use

Labyrinth Learning  http://www.lablearning.com

EVALU
ATIO

N O
NLY



3. Click the menu button, and then click Standard to return the Calculator to normal.

4. Close the Calculator.

C
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58 Chapter 3 | Windows Programs

 Skill Builder Exercises

skill builder 3.1 Use Paint

In earlier exercises, you tried some Paint tools. In this exercise, you will create a real 

drawing.

1. Open Paint: Start→Windows Accessories→Paint

Use the Start menu scroll bar to go down to Window Accessories and, if necessary, to 

Paint.

2. Maximize the Paint window.

3. Use some of the tools and colors to draw a picture of a sunset.

The sunset does not have to look perfect. This is just to practice using the mouse and 

dragging to draw. Many programs let you do this. 

4. When you are finished, close Paint.

5. If Paint asks if you want to save your work, click No.

If you already know how to save a file, click Yes and give the file a name.
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skill builder 3.2 Use the Calculator

In this exercise, you will use the Calculator program to multiply, divide, and subtract 

numbers.

1. Open Calculator: Start → Calculator

2. To multiply, press these buttons: 3 x 12 =

3. To multiply, press these buttons: 25 x 2 =

4. To divide, press these buttons: 80 - 4 =

5. To divide, press these buttons: 36 - 12 =

6. To subtract, press these buttons: 99 – 43 =

7. To subtract, press these buttons: 52 – 12 =

8. When you are finished, close Calculator.

skill builder 3.3 Play a Game

In this exercise, you will play Solitaire. If you have never played Solitaire with cards, 

ask a friend or your teacher to explain how to play the game. Playing this game will 

give you good practice using the mouse.

1. Open Solitaire: Start → Microsoft Solitaire Collection → Classic Solitaire Klondike

2. Close any windows that may open before you see the game. Your teacher can help

you if you cannot get to the game.

3. Click Play as a Guest, if necessary.

4. Click Klondike.
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60 Chapter 3 | Windows Programs

5. To move one of the cards, click on it. Hold down the mouse button and drag it to

a new place. If you put a card in the wrong place, it will not stay there. It will jump

back to where it was.

6. When you want to turn over a

new card, click on the pack at

the top.

7. Start putting the aces in the four shaded

areas and build up from there. The suits

(pictures on the cards) must match in each

top pile. You must put all the cards in the

top piles to win.

8. If you want to start a new game, click New Game on the bottom-left side of the

window.

9. When you are finished playing, click the Close button.
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personal project 3.4 Draw a Map

In this exercise, you will draw and print a simple map with the Paint program.

1. Open Paint: Start→Microsoft Accessories→Paint

2. Draw lines to create a simple street map of the area around your house.

To draw straight lines, hold down the [Shift] key as you drag a new line. 

3. Use the Text  tool to add street names. Click near where you want to type the words. 

Hold down the mouse button and drag a text box. Then you can type a street name 

inside the box. Make a new box for each name. After you type each street name, click 

outside of that text box before you make a new text box or draw another line.

4. To print the map, choose File→Print and then click Print again.

5. Close Paint without saving the map. (Or, if you know how to save a file, use

File→Save As to save it.)

TIP!
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62 Chapter 3 | Windows Programs

 Paired Conversation 

With a partner, take turns reading the A and B parts of the conversation.

Student A Yesterday we learned how to minimize a window.

Student B Yes, I remember. The window disappeared but did not really close.

Student A Do you remember how to maximize a window?

Student B Yes. Now let’s talk about what we learned today.

Student A Today we learned about hardware.

Student B Is that like the computer and the monitor?

Student A Right. We also learned about software.

Student B That is like Word and Paint that are added into the computer.

Student A That is true.

Student B We also learned about the dialog boxes.

Student A Yes. Dialog boxes are important because they let you select the settings that you want.

Student B Did you play a computer game today?

Student A Not really. I just watched somebody else play.

Student B We practiced using the Paint program.

Student A I liked drawing a map and typing the names of the streets.

Student B Well, I am so glad we are learning so much!
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 Chapter Review

3.1 Verb Worksheet
Fill in the blanks. Select the best answer for each sentence using the computer verbs in 

the Word Bank.

WORD BANK

appear check clear

let up play preview

release view hold

1. You can _________________________ a document to see how it will look when you print it.

2. To _________________________ is when an object shows on the screen and you can see it.

3. To uncheck a box is called to _________________________ it.

4. To _________________________ means to click the box so that a checkmark appears.

5. To look at something is to _________________________ it.

6. To _________________________ means to use a computer game.

7. To keep your finger pressed on the mouse button is to _________________________

the button.

8. To _________________________ means to take your finger off of the mouse button.

9. To _________________________ means to release or let go of a button.
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64 Chapter 3 | Windows Programs

3.2 Fill in the Blanks
Fill in the missing words in the sentences below. Look at the picture of the Windows 

Calculator to help you. 

Exercise A: Add Two Numbers

1. Click the first _________________________.

2. Click the _________________________. sign.

3. Click the _________________________..

4. Click the _________________________. sign.

Exercise B: Multiply Two Numbers

1. Click the first _________________________..

2. Click the _________________________. sign.

3. Click the _________________________..

4. Click the _________________________. sign.
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